
The Basics of Milling

Introduction

This chapter is specifically for those who have not yet experienced the Milling process and will
endeavour to explain the fundamentals i.e. Machine Tool Axis Configuration, Tolerance and Thickness,
Tool Stepover, Climb and Conventional Milling, Cusp Heights etc.

WHAT IS MILLING?

Milling is the process of cutting away material by feeding a workpiece past a rotating multiple tooth
cutter. The cutting action of the many teeth around the milling cutter provides a fast method of
machining.

THE MACHINE TOOL

In the present climate many different configurations of machine tool exist. Some machines have the
table/workpiece stationary whilst the X, Y and Z Axes move and others may be constructed to allow
the workpiece/table to be the moving part whilst the axes are fixed.

In any condition the X, Y and Z­axes directions are always configured the same.

The X­axis is always considered as the longest
axis, where X+ will be the table motioning to the
left and X­ to the right.

The Y­axis moves from front to back of the
machine with the table motioning towards the
operator as the Y+ (positive) direction and away
being the Y– (negative) direction.

The Z­axis where the tool normally is located, has
the Z+ (positive) axis motioning up and away
from the workpiece/table and Z– (negative)
direction down towards the workpiece/table.



Some machine tools possess further axes to allow greater versatility when machining complex
components.

There could be a fourth axis added e.g. Rotary Table or a five axis configuration. Both can be either
manual set­up (operator controlled) or computer numerically controlled (CNC).

3­axis motion normally involves linear moves along the three principal directions (x, y and z), with the
tool being at the same orientation for all moves.

In 5­axis motion there are normally two more rotary axes in addition to the three linear axes (and of
course in addition to the tool rotation about its centre line).

METHODS OF MILLING

There are generally two methods of milling, Climb and Conventional.

Climb milling, is sometimes referred to as Down milling, where the direction of the cutter rotation is
the same as the feed direction. This method is probably the most common option on the shop floor and
will normally produce a better surface finish.

Climb Milling

Conventional milling is also sometimes referred to as Up milling where the direction of the cutter
opposes the feed direction.

Conventional Milling



TOLERANCE AND THICKNESS

Suitable values are required to control the accuracy and amount of excess material to be left on a
component by a toolpath. The parameters used for this purpose are preset and are called Tolerance and
Thickness. 

There are two independent locations for setting these values depending on whether the programmer is
performing an Area Clearance (Roughing) or Finishing operation. 

The Tolerance controls the accuracy to which the cutter path follows the shape of the component. It
can be above or below the stated Thickness value.

The Thickness is the amount of additional material to remain on the component surface after
machining. Again this amount can vary depending on the current Tolerance.

WHAT IS ‘STEPOVER’

The Stepover can be defined as the distance a tool moves between adjacent toolpath tracks. The
distance or Stepover value determines whether the surface finish on a component is rough or smooth.

When using a flat­bottomed tool such as an End Mill, the Stepover value normally ranges from around
70% of the cutter diameter.

So a tool with a diameter of 10mm may have a Stepover of approximately 7mm.



When using a Ball nose cutter the Stepover will be considerably smaller when Roughing and Finishing
mainly due to the geometry of the tool.

A larger Stepover will ultimately give a more rough surface finish than a small Stepover. 

WHAT IS ‘CUSP HEIGHT’

The Cusp is the height of material remaining after subsequent tool stepovers and is directly related to
the diameter of tool used, Stepover value, and the Tolerance and Thickness values.

Ultimately a very small Stepover using a Ball Nose cutter will give a smaller cusp height and smoother
surface finish than if a larger Stepover was used with the same cutter.

 

The two diagrams here represent the difference in cusp heights.

Both use the same diameter Ball Nose cutter but the lower diagram shows a smaller Cusp height
because the Stepover is reduced hence a smoother surface finish.



PowerMILL 1. Introduction 

1. Introduction 

Introduction. 
PowerMILL is a stand-alone machining package, which can quickly create gouge free cutter 
paths on imported component data. PowerMILL supports Wireframe, Triangle, Surface, 
and Solid models created by other Delcam products or from neutral formats such as IGES. If 
the relevant PS-Exchange translators are purchased PowerMILL will directly import data 
created by the majority of non-Delcam packages. 

PowerMILL Environment 

�     Double click on the PowerMILL icon. 

Graphics Area 

Explorer area 

Pull Down menus are located across the top of the PowerMILL window. By placing the 
mouse over the menu and clicking with the left mouse key, this will open up the relevant sub 
menu. Further selection can be done by moving the cursor along             a right arrow ( ) 

The Main toolbar is as shown on the following page. Each icon has a specific function and 
by holding the cursor over it, an appropriate description (or ToolTips) is displayed. 
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1. Introduction PowerMILL 

On the right hand side of the screen is the Viewing toolbar.  By selecting one of the icons a 
different view of the model and global transform is displayed in the central or graphics area. 

View along the X-axis 

View along the -Y axis 

View along the Z-axis 

View along the -X axis 

View along the Y-axis 

View along the-Z axis 

Isometric View 1 

Isometric View 2 

Isometric View 3 

Isometric View 4 

Resize to fit 

Zoom In 

Zoom Out 

Zoom to Box 

Last View 

Refresh 

Block 

Plain Shade and access to other shading options 

Wireframe 

Shade options from left to right:- 

Thickness - Machining Mode - Default Thickness - Default Machining Mode - Draft Angle - 
Minimum Radius - Multicolour - Plain 
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PowerMILL 1. Introduction 

Mouse buttons 
Each of the three mouse buttons perform a different dynamic operation in PowerMILL. 

Mouse button 1: Picking and selecting 

This button is used for selecting items off the pull down menus, 
options within forms, and entities in the graphics area. 

Mouse button 2: Dynamics 

Zooming in and out: - Hold down the CTRL key and mouse 
button 2. Move the mouse up and down to zoom in and out. 
Pan around the model: -Hold down the SHIFT key with mouse 
button 2. Move the mouse in the required direction. 
Zoom Box - hold down the Ctrl and shift key, drag a box around 
the area to zoom into using the middle mouse button. 
Rotate mode: Hold down mouse button 2 and move the mouse, 
and the rotation is centered about the trackerball. 

View Spinning- Dynamically rotate the view and quickly 
release the mouse. The faster the mouse the faster it will spin. 
This feature is switched off by default. 

� Select Tools -> Options, select the View tab 
and tick the option Spin View. 

Mouse button 3: Special Menus & PowerMILL Explorer Options 

When this button is pressed it brings up a local menu relating to 
whatever the mouse is over, such as a named item in the 
PowerMILL Explorer or a physical entity in the graphics area. If 
nothing specific is selected the View menu appears. 
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1. Introduction 

Example 1 

PowerMILL 

For the first exercise an existing model will be imported and used to illustrate some of the 
basic visual display options. 

�     Select File -> Import Model. 

The open examples form 
appears and the large icon eg 
provides access to an area 
within the PowerMILL 
product software tree where 
sample models are stored. 
The icons marked 1 and 2 
can be customised by the 
user to locate areas where 
data for live jobs are stored. 

�
�

Click on the eg   icon. 
Select the phone.dgk model and then click on Open. 

The phone model is displayed as a wireframe viewed down the 
Z-axis. Only part of the model is visible, as it is too large to fit in 
the current view. To display the whole model the Resize to fit 
icon in the Viewing toolbar is selected. 

� In the Viewing toolbar, select the Resize to fit icon. 

The view of the model is scaled to the full screen. 
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PowerMILL 1. Introduction 

� Select the ISO 1 icon. 

You can now see the entire model quite 
clearly in an isometric wireframe view. 
To see it shaded you need to select the 
shaded wire option. 

� Select the Shaded Model icon. 

This displays the shading on top of the 
wire. To remove the wire view and show 
the model as shaded only, then click on 
the pressed in wire button. 

� Select the Wire Model icon. 

By pressing the wire icon again, the 
wireframe is hidden showing the model 
only in shaded. 

�
�

Click on the Shaded Model icon and then click on the wire view icon. 
Try the other Viewing icons and observe the results. 
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1. Introduction PowerMILL 

Sometimes it is useful to be able to see inside a model. In order to do this, the model can be 
made translucent. 

�     Select the Shaded Model icon. 

� Right Click over the Model and select Translucency from the menu 

� Enter the percentage translucency you require 
(0 percent  = opaque, 100 percent  = transparent) 

The model is displayed in translucent shaded mode allowing the user to see internal details 

�     To return to normal shading set the translucency to Zero. 
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PowerMILL 1. Introduction 

PowerMILL Panes 

On the left hand side of the screen above the Explorer are the PowerMILL panes. 

These are used extensively to help organise your machining. The 
standard format pane is denoted by the PowerMILL symbol and 
contains the explorer tree categorised into NC Programs,Toolpaths, 
Tools, Boundaries, Patterns, Feature Sets, Workplanes, etc. 

The second pane is the HTML browser used for viewing HTML files or Help files and the 
third pane opens the PowerMILL Recycle Bin. 

� Select File -> Delete All. 

PowerMILL Help 
PowerMILL comes complete with it's own On-Line Help which is accessed via the help 
menu. 

� Select Help -> What's New. 

An summary of all the new functionality available in the current version of PowerMILL is 
loaded into the html pane. 
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1. Introduction PowerMILL 

� Select Help -> Contents 

Another extremely useful feature is the Context sensitive Help available on all forms. 

� Select the Feedrate icon from the top toolbar to 
bring up the Feedrate form below 

� Select the Question mark at the top of the form 

The cursor will be displayed with a question mark next to it. 

�       Click on any of the white areas on the form. 

Help on that specific form or topic will be displayed 

�     Select File Close Project. 
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PowerMILL 2. Machining Set Up 

2. Machining Set up 

Preparation before creating toolpaths 

The following list is a summary of basic setting up procedures required before the toolpaths 
are created. 
It is important to spend a little time gathering as much information as possible about the 
model before actually applying toolpaths. 
PowerMILL has some unique tools that allow parts of the model to be measured whether it 
is a gap or an internal radius. 
Various shading methods can also be used to get a quick idea visually of the minimum radius 
and draft angles. 
An imported model might be in an unsuitable orientation for machining in which case 
PowerMILL allows the user to change the coordinate system as required. 
Some of these methods will be used within the following chapter. 
The following list could be used as a check list for setting up any job within PowerMILL 
and generally represent the basics that should be followed before applying any toolpaths. 
Note:- Items 8 9 &10 below can be redefined retrospectively on an existing toolpath. 

1. Loading a model into PowerMILL. 

2. Viewing the model 

3. Orientating the model around an Active Workplane where required. 

4. Gather information on the model i.e. Minimum radius / Draft angles. 

5. Measure the model. 

6. Material block definition. 

7. Cutting tool definition. 

8. Feed rate and Spindle Speed Settings. 

9. Rapid Move Heights. 

10. Tool Start and End Point. 

11. Save the Project. 

1. Loading a Model into PowerMILL 

A selection of sample model files are supplied and installed with PowerMILL and these are 
retrieved from a default directory called Examples. 
The usual method of importing a model into PowerMILL is by selecting File > Import 
Model from the top pulldown menus. 
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2. Machining Set up 

�     Select File ->Examples. 

PowerMILL 

A variety of different types of Model 
format can be Imported into PowerMILL. 
These can easily be discriminated on the 
form using the filter Files of type to widen 
or narrow the choice for file extension. 

� Click on the file name speaker_core.dgk and then Open. 

� Select View from top (Z) followed by Resize to fit from the 
Viewing toolbar to the right of the graphics area. 

The model will be displayed (as shown) in the PowerMILL 
graphics area looking down the Z-axis with X aligned from left to 
right and Y from bottom to top. 
In most cases the X dimension of a machine tool table will be 
greater than Y in which case the longer side of the component may 
be in excess of the travel limits in Y. 
If this is the case it will be necessary to align the component with 

the longest side along X to ensure that it can be positioned within 
the travel limits. 

2. Viewing the Model 
Although the model is displayed it is a good idea to look at it from all angles to fully 
understand its size and features. 

� Select an isometric ISO 1 view. 

Although it is possible to rotate the actual component 
this is not the generally the most effective approach. 
An additional moveable datum (Workplane) will be 
created and rotated through 90 Degrees to effectively 
create the condition that the longer side of the component 
is parallel with the front of the machine. 
The original coordinate set-up can then easily be re- 
activated for tasks such as checking dimensions. 
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PowerMILL 2. Machining Set Up 

3. Orientate the Model using a Workplane. 

The model needs to be rotated to leave the longest lower front edge of the model aligned to 
the front of the machine tool i.e. along the X-axis. 
Note. It is best practise to create a Workplane (moveable datum) and Rotate it about the 
model. 

� Right click over Workplanes in the PowerMILL Explorer and select 
Create Workplane. 

Workplanes are alternative or additional component datums 
that can be moved and/or orientated within the global 
environment. They are frequently used in 3 Axis machining and 
are an essential item in the application of 3plus2 and 
machining strategies. 

5-Axis 

The Workplane creation and editing form will appear. 

For easy identification it is recommended to appropriately rename any entity created in the 
Explorer. 

�
�

In the above form modify the Name to Datum. 
In the above form set the Active Workplane to Datum. 
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2. Machining Set up PowerMILL 

The next step will be to rotate the new Active Workplane to indirectly re-orientate the 
model. 
Note:- It is also possible (but not generally good practise in the long term) to Rotate and/or 
move the actual model relative to the active coordinate system. 

�
�

Enter Angle 90.0 before selecting the Rotate - Around Z icon. 
Accept the form. 

� Select a View from top (Z) and observe the effect of the rotated, Active 
Workplane producing a more suitable machining position for the model. 

It will not always be necessary to create and rotate or move a Workplane after import into 
PowerMILL. It depends on the original, orientation of the model when exported from the 
CAD software. 

Information regarding the model dimensions in relation to the world datum (Transform) or 
(if present), an Active Workplane can be obtained. 
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PowerMILL 2. Machining Set Up 

� In the explorer Right click over Models and select Properties. 

The values in this form can be copied (Ctrl C) and then pasted (Ctrl V) into other forms. 
The Workplane is moved up in the Z plane so that it is situated at the maximum height of 
the model. 
The form shows that the current maximum Z value is 115.47048mm. It will be necessary to 
move the Workplane by 115.47048 to position it at the maximum height of the model. 

�

�

Highlight the Maximum Z value (115.47048) by swiping over it with the left 
mouse button and press Ctrl C on the keyboard to Copy the value to the 
buffer. 

Eject the Model Properties form by clicking X in the top right corner. 
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2. Machining Set up 

�

PowerMILL 

In the explorer Right Click over the Workplane named (Datum) to access 
the local pull down menu. 

�

�

�

Select Edit - Workplane to open the form (above right) and use Crtl V to 
paste the previously stored value (115.47048) into the Distance box before 
selecting the Relative Position - Along Z icon. 
Accept the form. 

Select a Y- view. 

The Workplane is now in position on the 
top of the model. 

4.   Minimum Radius and Draft Angle shading views.   

Visual checks can be made quickly with the use of two shading options found in the views 
menu on the right hand side of the screen. 
It is useful to know before generating tools and toolpaths what the minimum radius is on the 
model and also whether there are any undercuts or draft angles. 

� Open the Shading Toolbar by clicking the small arrow as shown above. 

� Select the Minimum Radius Shade icon on the toolbar. 
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PowerMILL 2. Machining Set Up 

Any internal radii that are smaller than the specified Minimum Tool Radius will be shaded 
RED. The settings are located in the explorer - Model pull down menu in Drawing 
Options. 
Examine the model to identify areas that are inaccessible to the specified radius (shaded 
Red). 

The two internal radii can be seen shaded red visually identifying that they will not be 
machined to their correct size if the default value tool was used. 

The specified Minimum Tool Radius can be modified to suit in the Drawing Options area 
within the Models menu in the explorer. 

�     In the explorer Right click over Models and select Drawing Options. 

� Change the Minimum Tool Radius value to 5. 

The shading on some parts of the model has changed from Red to Green signifying that from 
a finishing viewpoint these local areas are fully accessible to a Dia 10 Ball Nose cutter. 

�     Change the Minimum Tool Radius value to 2. 

All of the red areas have now disappeared which suggests that the maximum tool size 
guaranteed to access all areas of the component would be a Dia 4 Ball Nose cutter. 

Issue PMILL 7 17



2. Machining Set up PowerMILL 

The model can also be visually inspected for the size of draft angles and undercuts. 

�     Select the Draft Angle Shade icon on the shading toolbar. 

The model is shaded in three different colours, red, green and yellow. 
The red areas represent angles equal to or less than the current Draft Angle specified in the 
Drawing Options form (default is 0). 
The green areas represent angles above the current Warning Angle specified in the Drawing 
Options form (default is 5). 
The yellow areas represent the areas between the current Draft Angle and Warning Angle. 
On this particular model the yellow areas represent angles between 0 and 5 degrees. 

� To check for undercuts change the Draft Angle to -0.2 and the Warning 
Angle to 0.2. 

All of the red areas have disappeared and all that remain are green and yellow. If any red 
areas remain then these would indicate an undercut situation greater than -0.2 degrees. 
The yellow areas indicate on or near vertical faces because the difference between the Draft 
and Warning Angles is so small. 

�

�

�

�

Accept the Drawing Options form 

Select the Draft Angle Shade icon 

Make sure the Wireframe 

again to turn off the shading. 

icon from the View toolbar is on so the 
model is displayed in Wireframe only. 

5. Measuring the model. 

The user may require dimensional information relating to certain features on the model. A 
measuring tool is provided in PowerMILL that allows the user to snap in the graphics area to 
obtain dimensions based on points lines and arcs. 
Before any such measurements can be taken the PowerMILL, Snap Filter will need to be 
modified. 

� From the top Pull Down menus select Tools > Snap Filter and use the left 
mouse key to untick - Anywhere. 

If Anywhere is unticked then measurements can be only be 
snapped onto the remaining ticked entities and not in free space. 
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PowerMILL 2. Machining Set Up 

� Zoom into the area shown by the arrow below. 

We 

The gap at the bottom of the slot will be measured to determine its size and depth. 

� From the Main toolbar select the Measure model icon. 

The Model Measurement for appears defaulted to Line. An Anchor Point is required to 
commence measuring. 

� The PowerMILL Calculator form will open in Line measurement mode. 
Using the left mouse button drag a window around (or snap) point 1 shown 
below to display the XYZ coordinates in the form. 

Drag a window around (or snap) point 1. 

The Anchor Point is now selected and is 
represented by a small circle. 
The x, y and z values seen in the above form are 
relative to the Active Workplane 'Datum'. 

� Drag a window around (or snap) point 2 to obtain the final 'point to point' 
measurement information. 

A temporary line appears connecting the two points, and the information relating to the line is 
displayed in the form. 
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2. Machining Set up PowerMILL 

Minimum Radius is measured via the Circle tab combined with snapping three points on the 
model. 

� Select the Circle tab on the Model Measurement form and zoom into the 
area shown below. 

� Select three points along the arc either by dragging a small window 
around, or snapping onto each one as shown below. 

A temporary circle will appear after the third point is selected as shown. 

20 Issue PMILL 7 



PowerMILL 2. Machining Set Up 

The Circle measurement form will display details 
of the arc as shown. 

� Close the Model Measurement form and select an ISO 1 view. 

6. Material Block definition. 

The Block usually starts out as the initial material size prior to machining the component. It 
is often created with more specific dimensions to provide a more localised limit for individual 
machining strategies. There are also other methods available for a more complex definition of 
the area in which a machining strategy operates. 

�     Click on the Block icon                   on the top toolbar 

The Block form appears allowing the user to define the 
Block size either to the default, Max/Min Limits or by 
manually entering the minimum and maximum X, Y and 
Z values (or a combination of both). 

The Block size is automatically set to the model 
dimensions by clicking the Calculate button with 
Max/Min Limits set. Individual values can be edited or 
locked (greyed out) as required in addition to being 
calculated to include an offset by entering a suitable value 
in the box marked Expansion. 

�

�

Click on the Calculate button. 

Click on Accept. 
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2. Machining Set up PowerMILL 

The Block is displayed 
shaded by default. This 
can be shown as solid, 
partially transparent, or 
as a blue wireframe, as 
controlled by the 
Opacity slider on the 
Block form. 

The Block can be turned off graphically by selecting the block icon 
View toolbar on the right 

7.Cutting Tool definition 

from the 

The Tool definition forms are accessed from the icons in the Tool toolbar located to the 
bottom left corner of the graphics area. 

� Click on the down arrow to display all of the Create Tool icons. 

All of the tool types appear as icons. 

Placing the cursor over an icon will open a small box containing a description of the 
tool type (Tool tips). 

� Select the Create a Tip Radiused tool icon. 
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PowerMILL 2. Machining Set Up 

The Tip Radius Tool form 
opens into which the 
required tool data is entered. 
When the diameter is entered 
the tool length automatically 
defaults to five times the 
diameter, and this can be 
changed if not desirable. 

It is a good idea to input a 
suitable Name for the tool. 
This tool for example with a 
diameter of 50 a length of 
100 and a tip radius of 6 
could be called D50T6. 

The specified Tool Number 
can be output in the NC 
program. If the machine has 
a tool changer it will 
represent the carousel 
number. 

Shank and Holder definition will be covered later in the course during the chapter on 
Collision Checking. 

�
�
�

Enter a Diameter of 50 a Tip Radius of 6 and modify the Length to 100. 
Enter D50T6 in the box marked Name. 
Click on Close. 

The tool is now displayed on the screen and also appears as an entity in the Tools section of 
the explorer.  Note: If the mouse is positioned over the tool in the explorer a Tooltips 
window will open displaying details of the tool definition. 
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2. Machining Set up PowerMILL 

Any future changes to the tool are initiated through the explorer. 
To undraw the tool click the yellow light bulb icon. To 
deactivate the tool right click anywhere on the tool data in the 
explorer and click the name Activate (the tick will disappear). 
Selecting the Parameters option will open the tool definition 
form. 

The tool can be seen either in wireframe or shaded in the graphics window. 

�     Right click over the tool in the Explorer and select Shaded. 

8. Feedrate and Spindle speed settings 

The speed and feed rate settings need to be defined. 

�     Click on the Feed rates icon               on the Main toolbar. 

The Feed Rates form opens enabling the user to enter 
appropriate feeds and speed for the machining strategy. 

Cutting Feed Rate and Spindle Speed can be stored within the 
Tool definition and input by clicking the box Load From 
Active Tool. 
The value for the Plunge feed rate is controlleddefined as a 

proportion of the Cutting feed rate controlled by changing the 
value in Tools - Options - Toolpath -Tools - Plunge Factor - 
0.1 (default). If the Autoload box is ticked the Feed Rates 
form will update automatically when a Tool is activated. 

�     Leave the settings as default and click Accept. 
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PowerMILL 2. Machining Set Up 

9. Rapid move heights 

Safe heights in Z must be set at which the tool can travel at rapid feed rates without 
contacting the component or work holding devices. 

Safe Z 

Start Z 

Rapid 

Plunge 

Cutting 

Safe Z is the height to which the tool will retract for rapid moves across the work. Start Z is 
the height to which the tool will descend, at rapid feed rate prior to applying the plunge feed 
rate. 

�
�
�

Click on the Rapid Move Heights icon. 
In the resultant form select the Reset to Safe Height button. 
Click on Accept. 

The same principle can also be defined incrementally to 
enable safe rapid moves, locally within the component. 
In the section of the form labelled Incremental 
Heights, in addition to Absolute, two additional 
options are available Plunge and Skim. 

Plunge will enable the rapid feed rate to continue to a 
specified distance above the full plunge depth before 
the plunge feed rate cuts in. 

Skim will operate in a similar way to Plunge but with 
the addition of applying rapid horizontal moves, at a 
specified distance above the highest point across the 
component to the next plunge position. 
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2. Machining Set up 

10. Tool Start and End Point. 

PowerMILL 

This is a safe position for the tool to move to before and after each tool change or machining 
operation. Depending on the type of machine tool it may be the actual tool change position. 

�     Click on the Tool Start and End Point icon. 

The tool Start and End Point form appears in which the user 
full control in defining a safe position for the tool to start from 
following a tool change or previous toolpath. 
By default the tool position is set automatically at the Block 
Centre Safe. A more specific position can be defined by 
selecting a different option in the Method area on the form 
(First Point, First Point Safe, and Absolute). 
The tool End Point is also defined from this form 
independently from the Start Point. 

�
�
�

Select Start Point and in the Method area set Use to Absolute. 
Set the co-ordinates as X0, Y0 and Z 50. 
Click on Accept. 

The tool is now located at the new Start 
Point above the active workplane. 

Setting up is now complete and 
PowerMILL is ready to start generating 
toolpaths. 

11. Projects 

A Project is a folder used for maintaining a permanent copy of the data created in the 
PowerMILL explorer. This could include data such as Toolpaths, Tools, Workplanes, and 
other entities related to the machining strategies. The project will also retain the activation 
status of each entity when saved. The Model is also stored in the Project. 

The commands for the project are accessed through the File pull down menu and it is good 
policy to initially Save Project as early as possible during programming and then at suitable, 
regular intervals. 

When initially saving a Project the user has to decide on a suitable directory location on the 
computer. 
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� Select File -> Save Project. 

� In the form locate the folder C:\temp (or if it does not exist with C open 
select the create New Folder tab and rename it as temp). 

� Once C:\temp is accessed, enter the name, Speaker_Core in File name 
and then select Save. 

To update the stored Project apply Save Project as and when required. To create an 
additional copy, use Save Project As (This will require a new File name). 

The use of Projects to store component data, machining data, and associated settings is 
essential to enable the user to return and modify an existing machining process. In many 

Issue PMILL 7 27



2. Machining Set up PowerMILL 

cases an existing Project can be used as the start of a new one, using the existing settings as 
the basis for the creation of new or recycled toolpaths on a different component. 

Project data is stored in a folder that is identifiable by a PowerMILL icon. 

How the Project appears in Windows Explorer. 
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3. 3D Area Clearance 

Introduction 
The main strategies for roughing a 3D component Model are called 3D Area Clearance. 
These provide a choice of 2D material removal methods, which progressively machine the 
area (Slice), up to the component contour, down a sequence of user-defined Z Heights. 
There is also a similar group of strategies, 2.5D Area Clearance for use, exclusively with 
PowerMILL 2.5D Feature machining (covered on the final day of the course). 

Sometimes known as Waterline Roughing the cutter steps down to a specified Z Height and 
fully clears an area (Slice) before stepping down to the next Z Height to repeat the process. 

For some components a secondary Area Clearance strategy is applied using the Rest 
Machining options in conjunction with a smaller roughing tool. This will locally remove 
pockets of excess material inaccessible to the original Tool Reference Toolpath or Stock 
Model. This will reduce the degree of tool overload and provide a more consistent material 
removal rate for any subsequent Finishing operations. 

If the original material is in the form of a casting or fabrication then it may not be necessary 
to apply any Area Clearance machining but to go directly for a semi-Finishing strategy. 

Issue PMILL 7 29



3. 3D Area Clearance PowerMILL 

Toolpaths 
Suitable values are required to control the accuracy and amount of excess material to be left 
on a component by a toolpath. The parameters used for this purpose are preset and are called 
Thickness and Tolerance. 

Thickness is the amount of 
extra material specified to 
remain on the work-piece after 
machining. This can be applied 
generally (as shown), or 
independently as separate 
Radial and Axial values within 
the machining options. 
It is also possible to assign 
additional Thickness values to 
groups of Surfaces on the 
actual model. 

Coarse Tolerance Fine Tolerance 

Tolerance controls the accuracy to which the cutter path follows the shape of the work-piece. 
For roughing a Coarse tolerance can be used but for finishing a Fine tolerance must be used. 

Note where the Thickness value is greater than 0 it should always be more than the 
tolerance value 
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Raster Area Clear example 

�
�

�

Activate the D50t6 tool in the explorer. 
From the Main toolbar select the Toolpath 
Strategies icon. 
Select 3D Area Clearance Tab. 

� Select the option Raster AreaClear Model to open the following form. 

� Enter the Name D50T6_A1. 

� Set Stepover to 20. 

� Set Stepdown to 10. 

�

�

Keeping all other values as default, 
Apply the form. 
After the processing is complete 

Cancel the form. 

As soon as the Raster AreaClear Model form is opened an 
unprocessed Toolpath appears in the Explorer (the default 
name has been changed to D50T6_A1). 

The Toolpath icon can now be double-clicked to Activate and 
de-activate the toolpath. 

The + symbol can be clicked to open a full record of the data used to create the toolpath. 
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The dotted red lines represent Rapid moves and the light blue lines are the Plunge feed 
moves. The Plunge moves at present are longer than necessary resulting in time wasted by 
the tool feeding down in free space where most of the move could be Rapid. 
The existing toolpath will now be Recycled with new settings to improve the efficiency of 
Rapid movements across the component. 

� Right mouse click over the Toolpath icon in the explorer to open the local 
pull down menu. 

Note the toolpath can also be activated or 
deactivated from the Activate switch in the 
pulldown menu. 

�
�

Select Settings to reopen the Raster AreaClear Model form. 
Select the 'Recycle toolpath' icon (shown arrowed below). 
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�
�

Select the Rapid Moves Height icon from the main toolbar 
Select the Skim option and change the Safe Z to 5 and Start Z to 3 as 
shown below. 

� Accept the above form and then click Apply in the Raster AreaClear 
Model form and once processing is complete click Cancel to close the 
form. 

The tool will now plunge locally (pale blue move) from the defined Incremental - Start Z 
above each slice and rapid across the roughed areas by the Incremental - Safe Z (purple 
move). 

The toolpath has been recycled with the Skim option set in the Rapid Move Heights form 
and now uses Incremental Safe Z and Start Z values (Note; In practice more than one change 
can be implemented when Recycling or Copying a toolpath). 
This time a Copy of the above toolpath will be created using the Area Filter options to 
remove the single pass tooltracks which are stepping down each of the four corners. 
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�
�

Select Settings to reopen the Raster AreaClear Model form. 
Select the 'Copy toolpath' icon (shown arrowed below). 

� In the form locate the Area Filter section (lower left corner) and input the 
settings as shown below (Note Filter Only Enclosed Areas is unticked). 

All tooltracks spanning a distance less than the 
Tool Diameter (TDU) will be filtered out and not 
appear in the final Toolpath. 
The effect of unticking Filter Only Enclosed 
Areas means that the areas of toolpath outside the 
Block will be included in the filtering process. 

� Apply the Raster AreaClear Model form and once processing is 
complete click Cancel to close the form. 

The default Raster Area 
Clear strategy steps across 
the model with parallel 
tooltracks. The remaining 
edges around the model, 
contour are then removed 
by a single profiling pass. 

A new toolpath called D50T6_A1_1 is created with the corner machining filtered out. 
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Simulating the toolpath 

ViewMill provides a 3D graphical simulation that allows toolpaths to be checked before they 
are machined. ViewMill has it's own separate toolbar that can be accessed from the ViewMill 
button on the Main toolbar. There are currently 2 different versions of ViewMILL the 
intention being that the original will be phased out once the new version is fully developed. 
For the time being there is no real benefit from using the new version for 3-Axis applications. 
Below is an example using the original     Viewmill and in the following example on p39 the 
new version is applied. 

� Select the (Original Version) ViewMill icon located towards the 
right in the Main Toolbar at the top of the screen. 

The simulation toolbar appears. 

�
�

Select ISO 1 view of the model and scale it to be as large as possible. 
Select the ViewMill toggle icon. 

This toggles the display to the Viewmill environment 
and generates a shaded block. 

� Select the Shaded Tool icon. 

With the tool shaded, it is clear where the tool datum 
position is. The speed of the simulation is reduced if the 
tool is shaded. 

� Select the Start/Restart icon. 
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The toolpath is simulated displaying the material 
removal from the defined block of material. 
Click the Shaded Tool icon again to switch it off which 
in turn will speed up the simulation. 

The complete machined block. 

� Select the ViewMill toggle icon to return to the PowerMILL session. 

The above ViewMILL session will not be cancelled but temporarily put into the background 
so that any subsequent toolpaths can be simulated as a continuation from the above. 

� From the Main toolbar select File. 
Save Project to update the stored data. 

The Speaker_Core Project has now been updated to include 
The 3D Area Clearance toolpaths. 

� From the Main toolbar select File 
Delete All. 

� From the Main toolbar select Tools - Reset Forms. 

This restores all default PowerMILL settings in the forms without having 
to exit and re-enter. 
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Offset Area Clear example 

�     Import the model WingMirrorDie.dgk from PowerMILL_Data\models. 

�
�

�
�

Create a Tip Radiused tool of Dia 40 tiprad 6 and Name d40t6. 
From the Main toolbar open the Block form and Calculate a material 
Block to the full model dimensions. 
Reset the Rapid Move Heights and set the Incremental moves to Skim. 
In the Start Point form set the Start Point to Block Centre Safe and the 
End Point to Last Point Safe. 

� From the Main toolbar select the Toolpath Strategies icon .

� Select the option Offset AreaClear Model to open the following form. 
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�
�
�

Enter Name D40T6_D1. 
Select Ramping. 
Select Ramping Options 
Entering; 
Max. Zig Angle 4, 
Follow Circle, and 
Circle Diameter 0.6 
As shown below. 

� Input Type - All 
(default). 

� Input or modify the data as shown in the sections arrowed above and click 
Apply to create the Offset Area Clear toolpath shown below. 

The Offset Area Clear 
strategy using Type All 
follows both the contours 
of both the Model and 
Block then gradually 
Offsets into the remaining 
material at each Z Height. 
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� RMB on the toolpath and select 
Attach Active Tool to Start to bring up 
the Simulation toolbar 

The toolpath simulation toolbar will open. 

� Select the (New Version) ViewMill toggle icon. 

� Press the Play button to start the simulation. 

The simulation of the toolpath will start with tool displayed. 

• Click the Display button to bring up Simulation info form 

� Select the Shiny option 

� Select Never to undraw the tool 
(This will speed up the simulation) 

�

�

Close the form 

Press the Play button again on the Simulation toolbar 
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The finished result indicates that the 
current tool geometry is not suitable 
to fully access some features 
(arrowed) on the model. 
As a result a further Area 
Clearance strategy is required using 
a smaller tool to continue locally 
into the remaining areas. 
This technique is known as Rest 
Machining. 

� Select the ViewMill toggle icon to return to the PowerMILL. 

Rest Machining 
Rest Machining is localised removal of the remaining material inaccessible to previous 
toolpaths. The 3D Area Clearance forms contain options to apply Rest Machining either 
based directly on a previously defined Reference Toolpath or a Stock Model. 
The following examples illustrate Rest Machining firstly using a Reference Toolpath and 
secondly by using the Stock Model. 
The Stock Model represents the un-machined stock at any point in the machining process. It 
is applied by first creating a Stock Model entity by applying a Block, followed by various 
toolpaths. After each update, the stock model adjusts itself to show the un-machined material 
remaining on the block. 

Rest Machining using a Reference Toolpath 

�
�

Create a Tip Radiused tool of Dia 16, tiprad 3 and name d16t3. 
RMB over the Toolpath icon in the explorer. 

� Select Settings to reopen the Offset 
AreaClear Model form. 

� Select the 'Copy toolpath' icon. 

Note; all associated items originally used to create the 
toolpath will be activated. 
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� Activate the new tool, d16t3. 

Enter a new name D16T3_D1. 

The options arrowed control the Rest 
Machining limits by comparison with 
the previously defined toolpath 
D40T6_D1. 

Set Type to Model (This generates 
offset tooltracks, based solely on the 
Model contours). 

�

�

Untick Area Filter. 

Input or modify the data as shown arrowed above and click Apply to 
create the new Offset Area Clear toolpath shown on the following page. 
Cancel the form. 
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�
�
�

PowerMILL 

RMB over the Toolpath icon in the explorer. 
Select Attach Active Tool to Start. 
Select the ViewMill toggle icon access the existing ViewMILL session. 

• Click the Switch on Display button to bring up Simulation info form 

� Select the Rainbow option. 

� Close form and press play on the ViewMill simulation toolbar. 

�

The ViewMILL simulation 
shows this next toolpath 
shaded in a different colour 
where it has machined in 
areas the previous toolpath 
did not cover 

The Reference Toolpath 
finished to rough out 
material closer to the 
component form. 
This will reduce the risk of 
excessive wear or damage to 
tools used for the subsequent 
finishing operations. 

Select the ViewMill toggle icon to return to PowerMILL 
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Rest Machining using a Stock Model 

An alternative method of Rest Machining is the use of a Stock Model instead of a 
Reference Toolpath. One of the benefits of using a Stock Model is that the remaining 
material can be visualised and registered along with the associated toolpaths. 
The following example will demonstrate the creation of a Stock Model up to the end of the 
toolpath D40T6_D1 at which point it will be displayed as the Rest Material. The Rest 
Machining toolpath D16T3_D1 will then be used as the basis for creating a new toolpath but 
this time using the Stock Model. 

�     In the explorer, Activate the toolpath D40T6_D1. 

� In the PowerMILL explorer right mouse click Stock Models to open the 
local menu and select Create. 

� In the PowerMILL explorer right mouse click the newly created Stock 
Model icon and from the local menu select Apply - Active Toolpath 
First. 
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�

PowerMILL 

From the same menu select Calculate to create the Stock Model as 
shown below. 

� From the same menu again select Show Rest Material to display the 
Stock Model as shown below. 
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� From the same menu again select Drawing Options - Shaded to display 
the Stock Model as shown below. 

�
�

�

In the explorer Activate the toolpath D16T3_D1. 
Right click the toolpath icon and from the local menu select Settings to 
reopen the Offset AreaClear Model form. 
Select the 'Copy toolpath' icon (shown arrowed below). 

� In the form locate the Rest Machining section (lower right corner) and 
change the settings to use Stock Model   - 1 as shown below. 

�

�

Click Apply to create an alternative (more efficient) Rest Machining 
toolpath named D16T3_D1_1. 
Cancel the Offset Area Clearance Form to reveal the following toolpath. 
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Although the Stock Model has been 
used to define the area to be machined 
the new toolpath is not automatically 
added to the Stock Model. This is 
carried out as a secondary operation if 
required by the user. 

� Right click over the active toolpath, D16T3_D1_1 in the explorer and 
select Add to - Stock Model. 

It is also possible to Right Click on the named, Stock 
Model in the explorer and select Apply - Active 
toolpath Last. At this stage the Stock Model will 
disappear from the screen. 

� Right click over the named, Stock Model in the explorer and select 
Calculate to create the updated Stock Model as shown below. 
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�

�

�

�

From the Main toolbar select File - Save Project and save the Project as 
C:\temp\Wing_Mirror_Die. (See Chapter 2 for full details of method) 
In the explorer Right click over Toolpaths and select Delete All from the 
local menu. 
Use the same method to Delete All   - Models and Stock Models (Do not 
Apply to the Tools section in the explorer). 

From the Main pulldown menus select 
Tools - Reset Forms. 

This restores all default settings in the forms without having to exit and re-enter. 

Note: The above items deleted from the explorer can at this stage be recovered as they have 
been transferred to the PowerMILL Recycle Bin.  If File - Delete All is applied from the 
main pulldown menus all entities by-pass the Recycle Bin and as a result cannot be 
recovered. 

�     Left mouse click on the Entity Recycler pane to open the Recycle Bin. 

�

�

�

Right mouse click over an entity in the Recycle Bin to view the local menu 
options to Recover or permanently Delete an item. 
Recover a Toolpath from the Recycle Bin and check that it has been 
reinstated in the Toolpaths section of the PowerMILL explorer. 
Return to the PowerMILL explorer and if necessary, apply Delete All 
separately again on Toolpaths, Models and Stock Models. (Do not Apply 
to the Tools section in the explorer). 

Offset Area Clearance - Type Model 

This variant of the Offset Area Clearance is designed for High Speed machining. It provides 
a very consistent material removal rate at the expense of an increased number of rapid moves 
across the component (This is accepted practice in High Speed applications). This strategy if 
applied correctly will dramatically help to minimise wear to both the tooling and machine. 
The strategy is based on the profile around the component at each Z Height being continually 
offset up to the material Block. 

�
�

Import the model Handle.dgk located in PowerMILL_Data\models. 
In the explorer - Activate the Dia 16 tiprad 3 tool d16t3. 
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�

PowerMILL 

�

�

�
�

�
�

From the Main toolbar open the Block form and Calculate a material 
Block to the full model dimensions. Lock the Z max and Z min values, 
enter an Expansion value of 10 and Calculate again. 
In Rapid move heights, click Reset to Safe Heights, and in Incremental 
Heights set the Rapid Move Type to Skim. 
In the Start Point form set both the Start Point and End Point to Block 
Centre Safe. 
From the Main toolbar select the Toolpath Strategies icon. 
From 3D Area Clearance select the option Offset AreaClear Model to 
open the following form. 
Enter data in the forms exactly as shown below. 
The Stepdown is to be defined manually as a single level from the Area 

Clearance Z Heights Form (If Z Heights already 
exist, Delete them by clicking the red cross located to the lower right of 
the form). 

�
�

Select Type as Model. 
Input Defined by Value 3.0 and select Calculate (After selecting Delete All 
existing Z Heights). 
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� Check the data as shown previously and click Apply then Cancel. 

Note: Shown with leads 
and links undrawn. 

�

�

Select an Iso 1 view as shown and right click over the toolpath icon in the 
PowerMILL explorer to open the local menu. 
Select Animate - Medium and observe the animation of the toolpath 
(select the Esc key to stop the animation). 

The tool will continuously climb mill, starting 
each tool track a distance from the material 
block to allow for acceleration to optimum Feed 
Rate. Each pass will maintain a very consistent 
material removal rate. The only negative side to 
the strategy is the occasional sudden changes of 
direction along the tool tracks. This can be 
improved using advanced settings to 
progressively straighten tooltracks as they offset 
further away from the Component form. A 
specified deviation from the nominal stepover 
will be required to allow this. 

�

�
�

Right mouse click over the Toolpath icon in the explorer to open the local 
pull down menu. 
Select Settings to reopen the Offset AreaClear Model form. 
Select the 'Copy toolpath' icon (shown arrowed below). 
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�

�

With the Offset Area Clearance form open again, tick the Smoothing 
Allowance option leaving the slider value as default (25%). 
Click Apply to create a new toolpath d16t3_hsm1_1 with the improved 
25% smoothed strategy. 

Compare the 2 3D Offset Area Clearance (Type - Model) toolpaths noting the progressive 
straightening of tool tracks on the second strategy (25% smoothing applied). 

�

�

From the Main toolbar select File - Delete All to delete all data from the 
current project 

From the Main toolbar select Tools 
Reset Forms 

This restores all default PowerMILL settings in the forms without having to exit and re-enter. 
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General information on Area Clearance Machining 
The following is reference information for the many different options contained in the Area 
Clearance form. This can also be found by using Help. 

Clicking the Thickness button on the Area Clearance forms opens the Axial Thickness box 
allowing the user to set separate values for Radial and Axial thickness. This faclity is also 
available on the finishing forms. 

Restrict Tool Overload 

With Restrict Tool Overload ticked as the tool reaches an 
specified overload situation PowerMILL automatically inputs 
a trochoidal path to eliminate full width cuts. This will occur 
in corners, narrow channels, slots, etc and the degree of 
movement is controlled with the slider as a percentage value in 
the form. 

Z Heights 
If Stepdown is set to Manual on The Area Clearance form, there are five ways of generating 
Z Heights; Number, Stepdown, Value, Intermediate and Flat. 

Number - divides the block equally into the defined number of Z Heights, the lowest of 
which will be at the bottom of the block. 

Stepdown - creates a Z Height at the base of the block and then steps up a defined Height in 
Z. The setting Maintain Constant Stepdown causes the distance between all levels to 
remain constant and will modify the stepdown to create evenly spaced levels as near to the 
specified value as possible. 
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Value - creates a single Z Height at the defined value. You can specify as many Z Heights as 
is required, but when using Value you must do so one at a time. 

Flat - Identifies flat areas of the model and creates a Z height (+ thickness) at these values. 

Intermediate - adds the specified number of Z Heights between existing Z Heights. 

Appending Z Heights 
Z Heights can be also be used from saved Area Clearance Toolpaths. When a toolpath is 
activated the Append button becomes active. 

Profiling 
A profile can be performed at each level to remove steps that will be left by the cutter Before, 
During, or After a Raster - Area Clearance strategy. Additional profile passes can be 
applied when machining either on either Every Z, or the Last Z level with Offset, Profile or 
Raster strategies. Note: Offset and Profile strategies inherently follow the component 
profile. 

When 
This determines when the profile pass takes place during machining. There are 4 options 

None - No profiling pass is performed 
Before - PowerMILL will perform the profiling first and then the raster path. 
During - As the raster path is generated it will find profile paths as it goes. 
After - PowerMILL performs the profile pass last. 

Cut Direction 
This determines the direction of the tool. Choosing a single direction will more than likely 
lead to more lifts generated. 

Any - this allows the cutter to travel in both directions allowing it to climb mill and 
conventional mill. 
Climb - this will force the cutter to only travel in one direction so that it is always 
climb milling. 
Conventional - this will force the cutter to only travel in one direction so that it is 
always conventionally milling. 

Final Profiling Pass 
This option is held in the profiling area of the main area clearance toolbar and allows the user 
to make an additional, final profiling pass to further reduce tool wear. 

Allow tool outside block 
The Allow tool outside block tick box is located in the Expert Area Clearance form, 
which is opened by selecting the tab midway down the right hand side of the main form. 
This enables the first pass of an Offset or Raster pass to be performed to the specified 
Stepover, rather than the full radius of the tool. 
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Ramping 
This provides a way to lead down onto a tooltrack where it is impossible to approach from 
outside the Block at the full machining depth (eg within a pocket). 

Tool 

Ramp Length 

Zig angle 

Zag angle 

The Zig angle is the angle of descent along the machining direction as the tool ramps into the 
material. There are 3 different types of ramp move following the geometry of the Toolpath, a 
Circle, or a Line. If the length of the Zig angle is limited to a finite distance a ramp move in 
the opposite direction, Zag angle can be applied. 

The Ramp Length is defined as 'Tool Diameter Units' (TDU). For example, with a 10mm 
diameter tool, A Ramp Length of 2 TDU's would equal 20mm. Normally the Ramp Length 
should be greater than the tool diameter to allow swarf to clear from beneath the tool. 

Zag Angle 
If a finite ramp length has been specified, then PowerMILL will insert Zag moves. The 
default setting for Zag angle has the Independent flag set - which means the angle, is 
defined manually. The default angle is 0 degrees. When unset, it will be the same value as the 
Zig angle. 

If Approach Outside is set, and where it is practical for it to operate without gouging it will 
take priority over Ramping. 

If the defined geometry for a Ramp move is such that it would cause a gouge then it will be 
replaced by a Plunge move. 
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Machining Flats 

PowerMILL 

The area clearance strategies in PowerMILL have an option that allows the user to control the 
way in which flat areas of the model are rough machined. These are found on the area 
clearance form under Machine Flats. 

�
�
�
�

Import the model PowerMILL_Data\Models\Flats.dgk 
Create a 12mm diameter End Mill tool and name it EM12 
Calculate the Block 
Set the Rapid Move Heights and check Start/End Point is set to default; 
Start Point - Block Centre Safe and End Point - Last Point Safe. 

�
�

From the Toolpath Strategies form, select Offset Area Clearance. 
Fill in the form exactly as below. 
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� Apply and then Cancel the form 

It can be seen that with Machine Flats - Off the toolpath has ignored the flat surfaces of the 
model. It has maintained a constant Stepdown value and completely performed area 
clearance across the material Block at each Z Height. 

�
�
�
�

Make a copy of the toolpath. 
Change the Machine Flats option to LEVEL (This is the default). 
Change the name to Flats Level. 
Apply and then Cancel the form. 

The area clearance toolpath now removes material from the flat surfaces leaving just 1.1mm 
this is equal to the thickness plus the tolerance set in the form. Where new slices have been 
added, the toolpath clears all the way to the edge of the block. 
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�
�
�
�

Make a Copy of the toolpath. 
Change the Machine Flats option to AREA. 
Change the Name to Flats Area. 
Apply and then Cancel the form. 

The toolpath now clears the flats as before but only extends to the edge of the component flat 
area. This provides a shorter toolpath than using the Level option. 

It is also possible to machine just the flat areas. This allows the user to rough the part first 
using Machine Flats set to OFF and then clear the flats in a second operation. 

�
�
�

Make a copy of the toolpath. 
Open the Expert part of the form by pressing the arrow at the right. 
Select Flat from the Slices options pulldown. 
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�
�

Calculate the slices. 
Apply and Cancel the form. 

The area clearance has now machined only the flat areas, the stepdown has been ignored 
The cutter avoids the holes resulting in a fragmented toolpath requiring many lifts. The area 
clearance can be made to ignore the holes if required. 

�
�
�

Make a copy of the toolpath. 
Open the Expert part of the form by pressing the arrow at the right. 
Tick the box next to Ignore Holes. 

The Threshold in TDU (tool diameter units) tells PowerMILL what size of holes to ignore. 
With the tool EM12 selected and the Threshold set to 2, PowerMILL will ignore any hole 
less than 24mm in diameter. 

�     Apply and Cancel the form. 
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The cutter now passes over the top of the holes without lifting giving a smoother toolpath. It 
should be noted that the flats at the bottom of the holes are still machined. 

If the amount of material left on the flats is large then several passes can be made to reduce 
the tool loading during the area clearance. 

�
�
�

�

Make a copy of the toolpath. 
Open the Expert part of the form. 
Select Multiple Cuts. 

Fill in the remaining options as 
shown. 

As the Flats are being machined using several passes it is a good opportunity to finish them to 
size on the depth (Axial thickness 0) but still leave 1mm on the sides (Radial thickness 1). 

� Click the Thickness icon to activate Axial Thickness (0). 

58 Issue PMILL 7 



PowerMILL 3. 3DArea Clearance 

� Apply and Cancel the Area Clearance form. 

Three passes are made at each flat area, the final one with a 1mm depth of cut that cuts to size 
in the Axial direction and leaves 1mm stock on in the Radial direction. 

INFORMATION 
It should be noted that by default, the PowerMILL - 3D Area Clearance strategies will only 
detect completely flat surfaces. If a model contains surfaces that are almost flat then they will 
not be recognised unless the Flat Tolerance is set with a suitable, higher value. This option is 
found on the expert page of the 3D Area Clearance form. 
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4. Raster, Radial, Spiral, and 
Pattern Finishing Strategies. 

Introduction. 
This chapter will cover Finishing strategies created by the downward projection of a 
Pattern, which include four types, Raster, Radial, Spiral and Pattern. 

PowerMILL generates toolpaths by projecting a pre-defined strategy down the Z-axis onto 
the model. The standardised geometry for Raster, Radial, and Spiral are generated by 
entering values into the Finishing Form. The resultant Pattern can be displayed by selecting 
Preview before executing the command by selecting Apply. The Pattern option requires a 
user-defined geometric form (active Pattern), which is projected down Z onto the model as a 
toolpath. 

A Preview of the four pattern strategies are shown, looking down the Z. 

Raster Radial 

Spiral Pattern (User Defined) 
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Raster Example 

�

�

PowerMILL 

Delete All and Reset forms and from File > Examples select the model 
chamber.dgk. 
Calculate the Block and define a Dia 12 Ball Nose tool named bn12. 

The model and tool are displayed.. 

� Select the Rapid Move Heights icon from the top toolbar and in the 
form click Reset to safe heights then Accept. 

� Select the Start and End Point icon 
Accept. 

from the top toolbar then 

Note that the default settings are Start Point - Block Centre 
Safe and End Point - Last Point Safe. 
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� Select the Toolpath Strategies icon from the 
top toolbar. 

� Select the Raster Finishing icon then OK. 

�

�

�

Name the toolpath 
Raster_basic. 

Enter the Tolerance 
as 0.02 and 
Thickness as 0. 

Enter Ordering - Two 
Way. 

The default tolerance of 0.1 
will give a fairly coarse 
surface finish. For a finer 
finish a lower value such as 
0.02 is used. A thickness of 0 
will machine the material to 
size, within the tolerance. 

� Select a tool Stepover 
of 1mm. 

� Apply and Cancel the 
Form. 
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On closer inspection the toolpath 
contains sharp changes in 
direction. 

Selecting the Arc Fit option in the form can eliminate these. 

�

�

Right click over toolpath Raster_basic in the explorer and select Settings 
from the available menu. 

Select the Copy Toolpath icon from the form. 

� Rename the toolpath Raster_arcfit. 

� Check the box Arc Fit and change the Arc 
Radius to 0.1. 

The Arc Radius (0.1) is multiplied by the tool diameter 
(12mm) to give a final radius of 1.2mm. 
This option is particularly good for HSM (High Speed 
Machining). 

� Press Apply and Cancel. 

� Zoom into the same area as previous to see the changes. 

Before Arc Fit After Arc Fit 
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Where the toolpath is stepping over it is lifting up to the Safe Z height each time. This is 
wasting time putting in these unnecessary lifts. To make the toolpath more efficient the 
Leads and Links can be altered. 

�
�

Select the Leads and Links icon from the top toolbar. 
Select the Links tab on the form. 

� Change the Short links to 
Circular Arc 

� Change the Long and Safe links 
to Skim. 

� Apply Links and Accept the form. 

Most of the lifts have been eliminated hence saving time and a 
circular arc has joined the links between adjacent toolpath 
tracks. 

The next stage is to Animate the latest, Active toolpath, Raster_arc fit. 

� To Animate the toolpath, 
right click over the toolpath icon in 
the explorer area, move down to 
Animate and select the required 
simulation speed. 
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When the Animation - Start is selected a new toolbar will appear at the top of the screen. 
This is the Simulation toolbar. 

When the Animation has finished it will be observed that the tool remains at the end of the 
last retract move. To send the tool back to the Start Point either press the Home key on the 
keyboard or select the Go to beginning button on the Animation toolbar. 

To see how a certain part of the toolpath runs in more detail it is possible to attach the tool to 
an area and use the Left/Right Arrow keys on the keyboard to make the tool move 
backwards or forwards along the toolpath. 

�     Position the cursor where required and right click on top of the toolpath. 

� Select Attach Active 
Tool. 

� Use the Left and Right 
arrow keys to move the 
tool forwards and 
backwards along the 
toolpat 

Tip: - Go to Help and in the Index 
area type Attach. You can then 
display more info on 'Attach 
Active Tool' 

� Experiment with some of the other options available on the Animation 
toolbar. 
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Radial Machining 

�
�

Select the Toolpath Strategies icon from the top toolbar. 
From the form select the Radial Finishing icon then OK. 

� Name the toolpath 
Radial. 

�

�

�

Make Radius End 45. 

Make Angle Start -60 
and End 240. 

Set Stepover to 2 and 
Two Way Joined Up 
ticked. 

� Set the view to look down the Z direction and select Preview. 

The route of the toolpath is shown with the Stepover being 
angular as determined by the radial pattern. 

� Apply and Cancel the form. 
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The toolpath follows the previewed radial pattern. 

� Animate the toolpath. 

Centre Point 
The Centre Point defines the origin of the radial pattern. By default the pattern is initially 
centred at the zero coordinates. This can be redefined if required to user-defined values or 
alternatively be centred to the middle of the block by clicking the Reset to Block Centre 
button. 

Start and End Radius 
These parameters determine the dimensions of the pattern and the direction of the first pass: 

First pass 
outwards First pass 

inwards 

Start 
rad 

End rad 

End rad Start 
rad 

Start angle and end angle 
These parameters perform two functions: The first defines the portion of the circular area to 
be machined, and the second determines whether the tool tracks are generated in a clockwise 
or anticlockwise direction. Angles are measured anti-clockwise from the positive X-axis. 

Start angle (120) > end angle (0) - tool tracks generate clockwise. 
Start angle (0) < end angle (120) - tool tracks generate anticlockwise. 
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Tool travels anti-clockwise Tool travels clockwise 

End angle 
= 120 

Start 
angle = 120 

Start angle = 0 End angle = 0 

Stepover 
The Stepover is the angle between consecutive passes. Note: - that further away from the 
centre point, the coarser the finish due to the passes becoming further apart. 

Join Up 
The tool tracks can be unidirectional or bi-directional depending on the setting of the Join Up 
flag. This is illustrated below: 

Ends of passes linked Ends of passes unlinked 

Join Up flag set Join Up flag unset 

Radial Exercise 

� Generate a Radial toolpath called Radial_1, using the tool bn12, 
Tolerance of 0.01 and Thickness of 0.5. Set the Centre Point at X 6.5 Y 
26. Select a Start Angle of 0, End Angle of 360, Start Radius of 0, End 
Radius of 12 with a Stepover of 1. 

The toolpath is generated in a small area. 

� Animate the toolpath. 
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Spiral Machining 

�
�

Select the Toolpath Strategies icon from the top toolbar. 
From the form select the Spiral Finishing icon then OK. 

PowerMILL 

�

�

�

Name the toolpath 
Spiral. 

Set the Thickness to 
0 and Stepover to 
0.5. 

Enter a Centre Point 
of X 8 Y 26, set Start 
Radius to 10, End 
Radius to 0 and 
Direction as 
Clockwise. 

A spiral toolpath is a 
continuous one, where there 
are no links between adjacent 
toolpath tracks. 

� Set the view to look down the Z direction and select Preview. 

The preview toolpath is displayed over an area of the 
model. 

�     Apply and Cancel the form. 

The spiral toolpath is produced. 
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Pattern Machining 
This technique requires a user defined Pattern for projection onto the model as a toolpath. 
This option can be used for applications such as scribe lines, lettering, and non-standard tool 
strategies. A Pattern is created either from within PowerMILL or as imported Wireframe 
data. 

� Delete All and Reset forms and from File > Examples select the model 
swheel.dgk. 

The component is circular as a result of which the Block - Z Minimum and Z Maximum 
will be developed as a Circular billet. 

�     Select the Block icon from the top toolbar. 

� Select Defined by - Cylinder. 

The Radius is worked out automatically when the 
Calculate button is clicked 

�       Select Calculate. 

� To provide more stock on the base Modify 
the Min Z value to -1, Lock the value, and 
Accept. 

� The Block can be displayed as wireframe or of variable Opacity up to 
solid, depending on the position of the Opacity slider switch. 
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Before the Pattern finishing strategy is created, a preliminary Area Clear strategy is 
required to remove the bulk of the material, leaving 0.5mm, followed by a Semi Finishing 
Strategy leaving 0.2mm prior to the final Finishing. 
The object of this Pattern exercise is to consolidate some of the training covered earlier as 
well as allowing the user to simulate the Pattern strategy at the correct stage in the overall 
machining process. 

�

�

�

Define a Tip Radiused tool with Diameter 10, Tip Radius 1 called D10T1 
and make this Tool Number 1. 

Define a Ball Nose tool with Diameter 6 called BN6 and make this Tool 
Number 2. 

Activate the D10T1 Tip Radius tool. 

�
�

In the Rapid move heights select Reset to Safe Heights. 
Calculate an Offset AreaClear Model toolpath using the following 
parameters: Name - RoughOp1, Tolerance 0.1, Thickness 0.5, Stepover 
5.0, Stepdown 1.0, and Cut Direction Climb. 

�

�
�

Simulate the toolpath in Viewmill to 
give a result similar to as shown left. 
Activate the BN6 Ball Nose tool. 
Calculate a Spiral Finishing toolpath 
using the following parameters: 
Name - SemiFinishOp1, Tolerance 
0.02, Thickness 0.2, Stepover 1.0, 
Centre Point X 0 Y 0, Radius - Start 
62.0 and End 0.0, and Direction 
Clockwise. 
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�
�

Simulate this new toolpath in Viewmill. 
Right click over the Semi Finish toolpath in the explorer and select 
Settings. 

�
�

From the form select the copy icon. 
Enter a new Name - Finish, change the Thickness to 0.0 and Stepover to 
0.5 then Apply and Close the form. 

� Simulate the final toolpath in 
Viewmill to give this result. 

A Pattern finishing strategy will be now 
applied to machine the text, Engraved into the 
component. 

A suitable, pre-defined Pattern will be imported for use with the strategy. 

� Right click the Pattern icon in the explorer and 
select Toolbar…. 

When Toolbar is selected off the Pattern menu it loads a new 
toolbar into PowerMILL. The toolbar contains icons to create an 
empty Pattern and load different types of entities into that empty 
pattern. 
The toolbar can be removed from the screen by clicking the small 
x at the right. 

�
�

Select the Create pattern icon. 
Click on the Insert file into active pattern icon. 
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�

�

�

Select the eg button. 

Double click the Patterns folder 
and then select Engrave.dgk. 

Select Open. 

The Pattern is made up of 2D flat geometry and lies at the bottom of 
the block. This will be dropped onto the model in 3D form while 
creating a single pass toolpath with a negative Thickness value. 

�

�

�

�

�

Define a Ball Nose tool 
with Diameter 1 called 
BN1 and make this 
Tool Number 3. 

Select a Pattern 
Finishing strategy. 

Enter the Name - 
EngraveOp1. 

Enter the Tolerance as 
0.02 and Thickness as 
-0.4. 

Select Pattern 1 (if not 
already selected). 

With Automatic set the pattern 
will be Dropped / Projected 
onto the model. 

� Select Apply then 
Cancel the form. 

By entering a negative 
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Thickness the tool will machine into the previously finished surface. This is frequently used 
for engraving, or to achieve a spark gap when machining part of a component as an electrode. 

� Open the Leads and Links form 
and Apply the Short, Long and 
Safe Links to Skim. 

The Pattern has been de-activated to enable a 
better visualisation of the toolpath. 

� Animate the toolpath and simulate it in Viewmill. 

The ViewMill block has been painted so that the 
final Pattern toolpath appears more pronounced 
during the simulation. 

� Save the Project as Pattern Machining in C:\Temp. 

Pattern Exercise 

The same imported Pattern will be used to engrave text into a telephone handset. 

�
�
�
�
�

Right Click Models on the Explorer and Select Delete All. 
Use File - Examples and load the model phone.dgk. 
Deactivate Toolpath EngraveOp1. 
Reset the Block, Rapid Move Heights and the Tool Start Point. 
Generate a Pattern Finishing toolpath leaving all values as before. 
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The Pattern, 'Engrave' used earlier has been re-used on this model. If the pattern is in the 
wrong position, it can be moved using the options on the Pattern - right click menu. 
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5. 3D Offset and Constant Z 

Introduction 
In this chapter 3D Offset and Constant Z finishing strategies will be applied to a model that 
consists of a combination of flat and steep areas plus a pocket with vertical walls. 

3D Offset Machining defines the tool Stepover relative to the 3D surface shape providing 
consistency over both flat areas and steep sidewalls. In this exercise applying this toolpath to 
the complete model without using Boundaries would not be recommended. Although this 
toolpath maintains a constant Stepover there is nothing to prevent the tool plunging with a 
full width cut into the deep pocket area. 
Boundaries used correctly will limit the 3D Offset toolpath to the flatter areas leaving the 
remaining steep areas to be machined using the Constant Z strategy. 

�

�

�

�

�

Delete All and Reset forms and Import the model 
PowerMILL_data\Models\camera.dgk. 

This model is a good example where it is 
a better option to use more than one 
finishing strategy. 3D Offset and 
Constant Z strategies will be used and 
they will be they will be kept separate by 
being limited to a Boundary. 
Before finishing can take place an Area 
Clearance toolpath will be created to 
remove the bulk of the material. 

Calculate the Block to component size, in Rapid Move Heights apply 
Reset to Safe Heights, and use Block Centre Safe for both the Start and 
End Point. 
Define a Tipped Radius tool with Diameter 25 and Tip Radius 3 called 
D25T3. 
Calculate an Offset Areaclear Model toolpath called RoughOp1 using a 
Thickness 0.5, Stepover 10 and Stepdown 3. 
Simulate the toolpath in Viewmill. 

The Viewmill simulation should look 
something similar to this. 
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�     Define a Ball Nose tool with Diameter 10 called BN10. 

PowerMILL 

We are now in a position to define the Boundary. Certain types of Boundary are calculated 
based on the Active tool. 
The Tolerance and Thickness values in the Boundary forms are important and normally 
reflect the same Tolerance and Thickness values with the subsequent toolpaths applied to 
them. 

� Right click on the Boundaries icon in the 
explorer and select 

Create Boundary -> Shallow. 

�

�

Input the Name - ShallowBN10. 

Input a Tolerance 0.02. 

� Tick the Use Axial Thickness box and enter a 
Radial Thickness 0.5 and an Axial 
Thickness 0. 

.
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A Shallow Boundary defines segments from areas on the 
model that are defined by an Upper and Lower threshold 
angle. It is therefore specifically suited to steep walled and 
shallow surface machining techniques. 

With Radial Thickness set to 0.5 the stock thickness left 
on the sidewalls from the roughing will not be machined at 
this stage. 

� Make sure that the correct tool is Active, in 
this case BN10. 

� Apply and Accept the form. 

With the model and toolpaths undrawn the Boundary should look something like this. It is 
made up of numerous segments each one dividing the model into steep and shallow areas. 
Any of which can be selected and individually deleted at any time (only before being 
assigned to a toolpath). 

� Select the Toolpath Strategies icon from the top of the screen. 
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�     Select a 3D Offset Finishing strategy from the form then OK. 

PowerMILL 

�

�

�

�

Enter the Name - 
3D Offset BN10. 

Select Direction 
- Climb. 

Enter a 
Tolerance 0.02. 

Enter a 
Thickness 0. 

Notice that the newly 
created, Active 
Boundary is 
automatically selected for 
use. If a different 
Boundary is required it 
can be selected from the 
pull down menu. 

� Select the Leads 
and Links icon 
and set the Lead 
In to None, Links 
- Short and 
Long Links to 
Safe 

� Apply and Cancel the form. 

The toolpath is calculated following the 
contours of the Boundary segments and is 
produced only on the shallow areas of the 
model. 
Further improvements can be made to this 
toolpath with respect to the Links between 
toolpath tracks. At the moment they are all 
at Safe Z. 

� Select the Leads and Links icon from the top of the screen. 
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�

�

Select the Links tab and change the Short Links to On Surface, the 
Long and Safe Links to Skim. 
Apply and Accept the form. 

The toolpath has now is now more 
efficient with the rapid moves at 
skim height and the short links 
being forced onto the surface. 

�

�

Simulate the 3D Offset toolpath in Viewmill. 

Right click over toolpath 3DOffsetBN10 in the explorer and select 
Settings from the pull down menu. 

Select the Copy icon on the form. 

�

�

�

�

Rename the toolpath as 
3DOffsetBN10_Spiral. 

Tick the box Spiral. 

Leave all other values the same then 
Apply and Cancel the form. 

The Spiral option is ideal for 
HSM (High Speed Machining) 
applications where ideally 
toolpaths should be as continuous 
as possible with the minimum 
sudden changes direction. Leads 
and Links are greatly reduced 
using this method. 
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Constant Z machining 

PowerMILL 

Constant Z machining projects each tool track horizontally onto the component at fixed 
heights defined by the Stepdown. 

As the component surface becomes shallow the actual tool step over increases until it 
becomes non-existent on flat areas. 
It is possible within the Constant Z finishing form to apply a variable stepdown by applying 
a Cusp tolerance in conjunction with a max and min stepdown. While this will generally 
provide a more consistant stepover relative to the angle of the model it will not help at all for 
very shallow or flat areas. 

� Select the Toolpath Strategies icon from the top toolbar. 

Select the Constant Z 
Finishing strategy. 
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�

�

�

Enter a Name 
ConstantZBN10. 

Set a Stepdown of 1. 

Enter the Tolerance as 0.02 

�

�

Set the direction to Climb. 

Set the Trimming to Keep 
Outside. 

� Apply then Cancel. 

By using the Boundary Trimming option Keep 
Outside, the toolpath is correctly limited to the steep 
areas of the model. 

If the Boundary had not been used the toolpath would have 
looked something like this. 

It can be seen that the parts of the toolpath on the shallow 
areas have an excessive Stepover. 

Issue PMILL 7 83



5. 3D Offset and Constant Z 

To further improve the new toolpath the Leads and Links will be modified. 

�

PowerMILL 

Select the Leads and Links 
icon at the top of the screen. 

� Select the Lead In tab and change 
the 1    Choice to Horizontal Arc 
Left, Angle 90.0 and Radius 2.0. 

Click the button Copy to Lead Out. 

st

�

�

�

Select the Links tab and change 
the Short, Long and Safe to 
Skim. 

Apply and Accept the form. 

The tool now leads in and out of the toolpath with a 
horizontal arc. 
If the tool lifts it will only lift by the skim distance 
taken from the first page of the Leads and Links 
form (Z Heights tab). 
The Rapid moves at skim height are purple in colour 
while the plunge moves are light blue. 
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� Simulate the toolpath in Viewmill. 

Other Constant Z Options 

Corner Correction to control whether changes of toolpath direction are Arc fitted, 
Sharpened or unchanged (None). 

The Pocket Machining option if ticked will allow independent machining of local features 
such as pockets completely from top to bottom. If unticked the whole area of the component 
will be machined at each separate stepdown height. 

Optimised Constant Z Machining 

This strategy is a mixture of Constant Z and 3D Offset machining. Where the model is steep, 
Constant Z is used and for other areas, 3D offset is used. 
Closed Offsets if ticked will cause the 3D Offset areas of the machining to be ordered to 
occur from outside to inside. The reverse applies if Closed Offsets is unticked. 

� Deactivate the Shallow boundary, ShallowBN10 in the explorer. 

�
�

Select the Toolpath Strategies icon from the top of the screen. 
Select Optimised Constant Z from the Finishing strategy form. 
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�

�

Enter Name - 
OptConZBN10. 

Select Closed 
Offsets. 

�

�

�

�

Set the Direction to 
Climb. 

Input a Stepover 
value of 1. 

Make sure no 
boundary is 
selected. 

Enter the 
Tolerance as 0.02. 

� Reset the Lead In 
and Lead Out to 
None. 

� Apply and Cancel. 

Note the consistent Stepover between tool 
tracks across the whole component. 

Optimized Constant Z has performed well 
in this example but it does take longer to 
calculate. Sometimes it is better to use 
Boundaries with a combination of 3D 
Offset and Constant Z. 
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� Select the Leads and Links icon from the top of the screen to bring up the 
form and select the Links tab. 

�

�

Change the Short links 
to On Surface. 

Change the Long and 
Safe links to Skim. 

� Apply and Accept the 
form. 

Both the Constant Z and 3D Offset parts of the toolpath currently use a 1mm Stepover. By 
ticking the box Use Separate Offset Stepover it is possible to apply a different, larger 
Stepover value to the shallow areas created with the 3D Offset strategy used in this hybrid 
form. 
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Interleaved Constant Z 

PowerMILL 

This is a form of Optimised Constant Z finishing with additional options which include a user 
defined Threshold Angle between the Constant Z and 3D Offset areas of the toolpath as well 
the option to specify an Overlap value between them. 

�
�

Select Interleaved Constant Z from the Finishing strategies form. 
Enter data exactly as shown in the following illustration. 

�

�

�

Enter Name as 
InterleavedCZ_BN10. 

Input a Threshold 
Angle value as 25. 

Input an Offset 
Overlap value of 2. 

� Apply and Accept the 
form. 

The Threshold Angle and Overlap are specified by the user. 
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Introduction to NC Programs. 

At this stage we will start looking at post processing a single toolpath from the explorer as an 
introduction to outputting NC Programs. NC Programs will be covered in more detail later in 
the course. 

All of the toolpaths that have been created in this chapter 
should appear in the explorer like this. 
This introduction will concentrate purely on the output of 
one single toolpath - Rough Op1. 

� Right click over toolpath Rough Op1 in the explorer. 

� Select the Create Individual NC Programs 
option. 

An NC Program is created called Rough Op1 and contains the 
toolpath. 

� Right click over the NC Program and select Settings. 
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The path to where the program will be 
output. 

Before post processing can occur the 
required option file (*.opt) must be 
selected. 

� Select the folder icon to open 
up the Select Machine 
Option Filename form. 

� Select the Heid400.opt and 

�

�

then Open. 
Select Write at the bottom of the NC Program form. 

Close down the subsequent form, which confirms the output using. 

The contents of the NC Program can be viewed by double clicking on it in the 
C:\ NC Programs folder and view it in WordPad. 
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